Implied Volatility
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Introduction

Implied volatility is a volatility measure implied through option prices in the market. It is of particular
interest to traders as it is one of the only forward-looking volatility measures we have at our disposal
and therefore doesn’t have to rely on historical price data.

In order to explain how this works, we need to understand a little bit more about options.

The Basics of Options

Options are derivative products that derive their value from an underlying asset. They can be built
around a wide-range of underlying assets (or variables), including stocks and indices as well as more
obscure assets built around the weather, for example.

A Call Option provides the holder with the right, but not the obligation, to buy an underlying asset
at a predetermined price on a pre-specified date.

Similarly, a Put Option provides the holder with the right, but not the obligation, to sell an
underlying asset at a predetermined price on a pre-specified date.

So, these options provide the holder with the opportunity to profit from exercising the option (by
buying the underlying asset at less than its current spot value, or selling the underlying asset at more
than its spot value) without having the obligation to exercise. Effectively, options deliver a payoff
profile which only has upside (as you wouldn’t exercise the option if you couldn’t profit from doing
so).

At the time of expiry, the payoff to the holder of a call option will be the underlying asset price at
expiry minus the predetermined strike price, and vice versa for the holder of a put option.

As an option provides the right, but not an obligation to buy (with a call) or sell (with a put) the
underlying asset, the buyer of an option must pay a premium - the price of the option.

Option Pricing
Six factors affect the price of an option:

Current underlying asset price (spot price)

Strike price (the price you pay for the asset when you exercise the option)
Time to expiration

Volatility of the asset price

Risk-free interest rate
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Dividend payments

We can consider all of these factors as known parameters, except for volatility, which we have to
estimate.

A complicated formula, called the Black-Scholes-Merton option pricing formula, is one of the most
common ways of pricing options used by professional traders and it uses the six factors mentioned
above. By incorporating the known parameters above into the equation, we can “back-out” an



implied volatility. Note that this volatility is implied by using the above parameters and real option
prices on the market, and because the market is forward-looking, we can consider the volatility
value that comes out as forward-looking as well.

Choosing Option Data and Volatility Smirks and Smiles

So we know that we can calculate implied volatility from real option data, but beyond choosing
options based on the underlying asset we are interested in, how we do we know which option to
choose?

Firstly, this guide and the accompanying spread sheet does not go into how dividends affect our
pricing model and hence the implied volatility outputs. For this reason, in order to get an accurate
representation of implied volatility, you should choose options on underlying assets that do not pay
dividends. Beyond this, maturity dates should represent the timeframe in which you wish to
investigate the volatility. For example, an option with one month expiry will imply volatility levels
determined by the market that are forward-looking by one month.

Secondly, it should be noted that with all parameters kept constant while varying the strike price,
the implied volatilities change. This is due to (Black-Scholes) model inadequacies. Typically, with
currencies we get a volatility smile, where implied volatilities are lowest when using strike prices
that are “at the money” (equal to the current stock price) and are higher as strike prices get deeper
“into or out of the money”.

“In the money” call options have strike prices less than the current underlying asset price, meaning
that if you exercised the option now you would make a profit. “Out of the money” call options have
strike prices that are greater than the current underlying asset price. These payoffs are reversed for
put options.

In equities, the story is slightly different and we can observe implied volatilities increasing faster with
“in the money” call options compared to those that are “out of the money”. Strike prices close to “at
the money” values typically still display the lowest implied volatilities.

Below is an example of a volatility “smirk” that is common throughout equities and equity indices.
Note that some assets, such as currencies, have more of a “smile” —that means the options that are
deeper “out of the money” (to the right hand side on this graph) would have slightly higher implied
volatilities much like the “into the money options”. In short, the smile is more symmetrical.
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Step-by-Step Guide to Calculating Implied Volatility

In this guide, we use “at the money” (or close to) S&P500 call options, in order to work out implied
volatility. This means we will pick options that have a strike price close to the current price of the
underlying asset. Note that this choice is arbitrary. You may prefer to use call options with strike
prices deeper into the extremities, or to calculate a number of implied volatilities over several strike
prices and determine your own average.

e Begin by opening the spreadsheet “Implied Vol” supplied along with this guide.

Note: This spreadsheet can only be used to calculate implied volatility using American and European
options on underlying assets that pay no dividends within the lifetime of the option. Furthermore, the
sheet is set up to compute implied volatilities from Call Options only.

Describing the Spreadsheet

A B E D E F G H I J K L 1] N [s] E Q
; Implied Volatility Spreadsheet (Zero Dividend Model
j Data Inputs Resources
5 Spot Price S Expiry Date Options Data  http://www.cboe. com/ or http:/finance.yahoo.com
6 Strike Price K Days -41386.00
7 Risk-Free Interest Rate r Risk-Free Rate http //www treasury gov/resource- Short-term treasury yield rates
& Time to Maturity T center/data-chart-centerfinterest- can be used as a proxy for a
9 rates/Pages/TextView aspx?data=yield risk-free rate
10 Observed Option Price Market Call Premium
1 . Dividends http:/ffinance.yahoo.com/ or company websites (for
Black-Scholes Thearetical B-S Call Premium #OIVJ0! equities)
12 | Option Price A q
13
:2 Solver Input and Output
16
17 Difference between real and theoretical prices (squared) " #DIVio! *This spreadsheet can be used fo find implied
volatility for American and European Call Options on
19 underlying assets that pay no dividend (yield or
20 |Volatility (sigma) absolute) within the lifetime of the option.
2 [
I -

22 Auxillary inputs to calculate B-S premia
23

24 d d2 N -“dash”

25 d1

267 #DIV/0! " #DIV/O! " #DIV/O!

First we will go through the primary section called “Data Inputs”. This section gives you a series of
variables which you must enter in order to output implied volatility. Cells highlighted in light blue
are the only cells that need changing in the spreadsheet.

Data Inputs:

Spot Price S The current price of the underlying asset in the
market
Strike Price K The price at which the holder of the option can

buy (if it is a call option) or sell (if it is a put
option) the underlying asset at upon exercise.

Risk-free rate r The risk-free rate of return. Usually taken as short
term government bond yields
Time to maturity T The time (in years) until the option expires. In the

spreadsheet this is calculated automatically from
the number of days until expiry (see “Days”)

- Expiry Date The option’s date of expiry

- Days The number of days until expiry from today until
the option expires. This is calculated automatically




in Excel once the expiry date has been entered

Observed Option Price | Market Call Premium The observed market price of the desired option

Black-Scholes B-S Call Premium The theoretical option price given the factors
Theoretical Option affecting option prices (as previously mentioned)
Price — Using the Black-Scholes-Merton pricing formula
A B C D E F G H
; Implied Volatility Spreadsheet (Zero Dividend Model)
j Data Inputs
5 Spot Price 5 Expiry Date
6 Strike Price K Days g
7 Risk-Free Interest Rate r
8 Time to Maturity T
9
1[1] Observed Option Price Market Call Premium These parameters are
. r
Black-Scholes Theoretical g ¢ 1\ promium D1Vl entered by the user.
12 Option Price
13
A B C D E F G H
; Implied Volatility Spreadsheet (Zero Dividend Model)
i Data Inputs
5 Spot Price 5 Expiry Date
6 Strike Price K Days -41386.
7 Risk-Free Interest Rate r
8 Time to Maturity T | 113.3863
9 These cells are calculated
1[1] Observed Option Price Market Call Premium automatically by the
X - : spreadsheet — do not edit
EIIa;I-c Schnles Theoretical B.S Call Premium ADIV/O! y.—| Sp
12 |Option Price them.
13

Solver Input and Output:

This section has a cell that calculates the difference between the observed option price in the
market and the theoretical Black-Scholes-Merton model price (Cell F17). The idea of this section is to
use Excel to conduct an iterative process to find a volatility input into the theoretical model that
finds an output price as close as possible to the observed option price in the market. The volatility
used is called the implied volatility and this is displayed in cell F20, inside the red box.

Black-Scholes Auxiliary Inputs:

This section provides inputs into the Black-Scholes-Merton equation. These cells should not be
manually altered at all.




1;1 Solver Input and Qutput
16
17 Difference between real and theoretical prices (squared) " #DIVIO!
18
19
20 Volatility (sigma)
21
22 Auxillary inputs to calculate B-S premia
23
24 d1 d2 N -"dash”
25 (d1)
26 7 #D0vi0r T #DvDl T EDIVIDL
Resources:

This section will be used to obtain information regarding options and underlying assets so we can

correctly calculate implied volatility.
Options Data — Shows where we can find relevant option data to input into the spreadsheet.

Risk-Free Rate — Gives a link to treasury yield rates, from which we can obtain reasonable estimates
of a risk-free rate for the US.

Dividends — Provides a link to yahoo finance in order to research whether there may be any
dividends on the underlying asset which we are analysing. If there are, we must ensure that the
payments do not occur within the chosen option’s lifetime. If there are dividend payments before
expiry of the option, the implied volatility supplied by the spreadsheet calculations will be inaccurate

and so, inadvisable to use.



Calculating Implied Volatility (S&P500 example)

e  First, click on the link within the spreadsheet to go to the CBOE website.

Resources

Options Data or http-/ffinance yahoo.com

Risk-Free Rate http/fwww.treasury.goviresource- Short-term treasury yield rates
center/data-chart-center/interest- can be used as a proxy for a

rates/Pages/TextView aspx?data=yield risk-free rate

. » } |
Dividends http./finance.yvahoo.com! o company websites (for
equities)
’
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o Next, type “SPX” into the ticker box and hit enter. This will bring up data on the S&P500
index.
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SPX (S&P 500 INDEX) 1555.25 0.0
Apr22 2013 @ 05:38ET

Calls Last Sale | Met | Bid | Ask | Vol | Open Int Puts. Last Sale | Net | Bid | Ask | Vol Open Int
SPXW132601175-E 0.0/ 0.0/ 0.0 0.0 0 0 13 Apr 1175.00 SPXN1326P1175-E 0.05| 0.0) 0.0 0.0 o 1475
SPXW132601200-E 0.0/ 0.0/ 0.0 0.0 0 0 13 Apr 1200.00 0.05| 0.0) 0.0 0.0 o 1007
SPXW132601225-E 0.0/ 0.0/ 0.0 0.0 0 0 13 Apr 1225.00 0.05| 0.0) 0.0 0.0 o 4312
SPXW132601250-E 0.0/ 0.0/ 0.0 0.0 0 0 13 Apr 1250.00 0.05| 0.0) 0.0 0.0 o 3887
SPXW132601275-E 289.50| 0.0 0.0, 0.0 0 10 13 Apr 1275.00 0.05| 0.0) 0.0 0.0 o 5250
SPXW132601300-E 25210/ 0.0/ 0.0, 0.0 0 3 13 Apr 1300.00 0.05| 0.0) 0.0 0.0 o 5050
SPXW132601310-E 247.80| 0.0 0.0 0.0 0 22 13 Apr 1310.00 0.05| 0.0) 0.0 0.0 o 4570
SPXW132601320-E 245.00) 0.0 00 00 0 88 13 Apr1320.00 0.05| 0.0/ 0.0 00 0 2225
SPXW132601325-E 24400/ 0.0 0.0 0.0 0 85 13 Apr 1325.00 0.05| 0.0) 0.0 0.0 o 5480
SPXW132601330-E 23780 0.0 00 00| O A7) 13 Apr 1330.00 0.05| 0.0/ 0.0 00 0 1077
SPXW132601340-E 0.0/ 0.0/ 0.0 0.0 0 0 13 Apr 1340.00 0.05| 0.0) 0.0 0.0 o 291
SPXW132601350-E 237683 0.0 0.0, 0.0 0 30 13 Apr 1350.00 0.10f 0.0 0.0 0.0 o 7818
SPXW132601355-E 0.0/ 0.0/ 0.0 0.0 0 0 13 Apr 1355.00 0.15| 0.0) 0.0 0.0 o 0
SPXW132601380-E 0.0/ 0.0/ 0.0 0.0 0 0 13 Apr 1360.00 0.10f 0.0 0.0 0.0 o 1882

When presented with the options data on the S&P500 it shows us near-term close-to-the-money
options (Calls and Puts). Within the option data, we are only interested in the “Calls” data on the
left-hand side. Within the “Calls” column, many call option contracts are listed and when we click on
any one of those contracts we can obtain more detailed information about that particular option. In
order to pick an option to analyse, we need to decide on the expiry date of the option and the strike
price we wish to use. The centre column presents both these pieces of data.

e Before continuing, note down the last available underlying asset price (in this case for the
S&P500), displayed above the top-right of the options table.
e Enter this price into the “Spot Price” cell in the spreadsheet — cell E5.



SPX (&P 500 INDEX) (1555.25)0.0
Apr22, 2013 @ 05:38 ET
Calls Last Sale | Met | Bid Ask Vol | Openint Puts Last Sale | Met Bid  Ask Vol Open Int
SPXW132601175-E 0.0/ ool oof ool o 0 13Apr1175.00 | SRXW1328P1175-E o0s| 00/ 0o oof o 1475
SPXW132601200-E 0.0/ oof oo| ool o 0/ 13 Apr1200.00 00s| 00/ 0o 00| o 1007
SPXW132601225-E 0.0/ oof oo| ool o 0 13 Apr1225.00 00s| 00/ 0o oo o 4912
SPXW132601250-E 0.0/ oof 0of ool o 0 13 Apr1250.00 005 00/ 0o 00| o 3887
SPXW132601275-E 28990 00| 00| 00| 0 10/ 13 Apr1275.00 2 00s| 00/ 0o oo o 5250
SPXV132601300-E 26210 00| 00| oo 0 31 13 Apr1300.00 26P13004 p0s| 00/ oo oof o 9050
SPXW132601310-E 24780 00| 00| 00 0 22 13 Apri310.00 2 00s| 00/ 0o oo o 4870
SPXW132601320-E 24900 0.0/ 00/ 00 0 98| 13 Apr132000 | SPXW1326P1320-E pos| 00 oo oof o 2225
SPXW132601325-E 24400 00| 00| 00| o 85 13Apr1325.00  SPXW1326P1325-F 00s| 00/ 0o oo o 5430
SPXW132601330-E 23780 00| 00| oo o 17/ 13Apr1330.00  SPXW1326P1330-E 00s| 00/ 0o oo o 1077
SPXW132601340-E 0.0/ oof oo| ool o 0] 13Apr1340.00 | SPXW1326P1340-E 00s| 00/ 0o oo o 291
SPXW132601350-E 23785 00| 00| oo 0 30| 13 Apr1350.00  SPXW1326P1350-E o0 00/ 0o oof o 7818
SPXW132601355-E 0.0/ oof oo| ool o 0 13Apr13S5.00 | SRXW1328P1355-E 015 00/ 0o oof o 0
SPXW132601350-E 0.0/ oof oo| ool o 0 13Apr1380.00 | SPXW1328P1350-E o0 00/ 0o oof o 1982
A B C D E F G H

; Implied Volatility Spreadsheet (Zero Dividend Model)
3 DataInp

ata Inputs
4
| 5 |Spot Price 3 Expiry Date
G Strike Price K Days -41386.00
7 Risk-Free Interest Rate T
8 Time to Maturity T
9
10 Observed Option Price Market Call Premium
11

. r

BIa;k—Schnles Theoretical B.S Call Premium SDIV/0!
12 Option Price
13

Return to the CBOE website and the options data table. The guide continues by looking at S&P500
Call options with expiry May 2013. As users of this guide you will not be able to learn from directly
copying this example. Instead, use the method outlined from now onwards to apply it to call options

on the S&P500 with an expiry date of your choosing.

e Scroll down to find a call option “close to the money” by clicking on the appropriate contract
with a strike price near to the S&P500 index’s last price. Ensure that this option has
reasonable Volume and/or Open Interest values so we know the option has been reliably
priced.

e In this example | choose an option with a strike price of 1550.

SPEW1303E1535-E 2750 0.0/ 0.0 0.0 0 82 13 May 1535.00
SPXW1303E1540-E 26.00( 0.0 0.0f 0.0 0 103 13 May 1540.00
SPXW1303E1545-E 20.30( 0.0 0.0 0.0 0 100 13 May 1545.00
SPXW1303E1550FE < | —4=aal anlaal gp| o
SPXW1303E1555-E Selected Contract | pg 1338 13 May 1555.00
SPXW1303E1580-E 12585 0.0 0.0f 0.0 0 373 13 May 1580.00
SPXW1303E1585-E 950 00 00 00 0 374 13 May 138500
SPXW303E15T0-E T.F00 00 00 00 0 1452 13 May 1570.00
SPXWT303E157 5 §.10) 0.0 0.0f 0.0 0 2321 13 May 1575.00
SPXW1303E1580-E 426 0.0 0.0 0.0 0 4100 13 May 1580.00
SPXW1303E1585-E 3.01 00 00 00 0 552 13 May 1585.00




This will load up a page showing you more details on that particular option.

spxw1303 Strike Price 1800 00 @

Price Data Table

Apr 22, 2013 @ 06:05 ET (DELAYED 15 MINUTES)

Last Sale 18.00 Tick Down

Time of Last Sale 04 . . Exchange CBOE
Ontion Price

MNet Change - Previous Close 18.00

Open 0.0 High 0.0

Bid 0.0 Low

nsk 00 Volume Expiration Date

Open Interest 2118 Expiration Date <E|EJE|3.-'2EI1 3 )

Using this screen we can determine the exact date that the option expires, as well as the price of the
option and the strike price. With this information and the S&P500 last price we have obtained 4 out
of the 5 inputs we need to calculate implied volatility.

Input those values into the spreadsheet now.

e Input the strike price into cell E6.
e Input the date into cell H5.
e Input the option price into cell E10.

A B = D E F G H
; Implied Volatility Spreadsheet (Zero Dividend Model)
j Data Inputs
5 Spot Price Expiry Date
6 |Strike Price Days 11.00
6|

7 Risk-Free Interest Rate

-7 = uwn

8 Time to Maturity 0.03013699
9
10 Observed Option Price Market Call Premium
1
Black-Scholes Theoretical B.S Call Premium 13.5811158

12 Option Price
13

The spreadsheet is configured for dates to be entered in English (UK) format. For those who use a
different date format to the British, cell H5 will need to be changed to the local format so that it
matches your system clock. Then you will need to enter dates in that format. If you enter the date in
British format when your system clock is set to another date format, the spreadsheet calculations

will not work.

e To change the date format, right-click on cell H5 and go to “Format Cell”.

10



2ro Dividend Model) w10 AN S B
.0 .00

:

Expiry Date @Cut B itpefiwww. choe com/
Days -

53 Copy o www treasury. govir
[ Paste Options: enter/data-chart-center/i
3 ites/Pages/Text\iew as
Paste Special... itp:/finance yahoo com/
Insert...
Delete...

Clear Contents
Filter b

19.526537 Sart 4 *This spreadsheef ca
volatility for American ar
underlying assets tha
absolute) within th

d Insert Comment

Format Cells...

Pick From Drop-down List...

o]

Define Mame...

&, Hyperlink...

o Select the appropriate location within the date tab, and press OK.

i N
Format Cells _ m

Mumber | Alignment | Font I Border I Fill | Protection |
Category:
General ~ | Sample
Number 03 May 2013
Currency
Acc:ountini Type:
=14/03/2001 -
Time T
Percentage 14 March 2001
- 14032001 =
Fraction 3
N 14/03/01
Scientific
14/3/01
Text 14.3.01
Special - i
Custom 2001-03-14
1 Locale (location):
|
English {LLK.} A i
English (Mew Zealand)
English (Philippines)
English (Singapore) |
= | ||English (South Africa)
English (Trinidad and Tobago
Date formats display date

asterisk (*) respond to changes in regional date and time settings that are spedified for the
operating system. Formats without an asterisk are not affected by operating system settings.

Next we need to find an appropriate risk-free rate to input into the formula. To do this we will go to
the Central Bank’s website of the country where the asset is listed. From there we will use a
government bond/bill rate with a similar maturity to the option we have chosen. Since we are
calculating implied volatility from options on the S&P500, we can find a risk-free rate from the US
treasury website.

11



e Use the link in the Resources section of the spreadsheet to navigate to the US treasury daily
yield curve rates page. Click on the link provided in the spreadsheet.

Resources
Options Data  hitp://www.cboe com/ or http:/ffinance yahoo.com
Risk-Free Rate |http://www.treasury goviresource- Short-term treasury yield rates
center/data-chart-center/interest- can be used as a proxy for a
rates/Pages/TextView. aspx?data=yield risk-free rate
Dividends http:/ffinance yahoo.com/ or company websites (for
equities)
En Espaiicl| Press Center | Blog | Contact Us. = = K ,

U.S. DEPARTMENT OF THE TREASURY

Search el

Advanced Search

Home About

Treasury For... Resource Cenfer Wy / Services Careers Connect with Us

Consumer Policy
SR Resource Center
Financial Markets,

Financial Institutions, and
Fiscal Senice Home » Resource Center » Data and Charts Center » Interest Rate Statistics » TextView

Financial Sanctions Daily Treasury Yield Curve Rates

24 et updates to this content
International
mmese data are also available in XML format by clicking on the XML icon

Small Business Programs ¢, are having trouble viewing the abave XML in vour browser, click here.

Tax Policy To access interest rate data in the legacy XML format, click here.
Select type of Interest Rate Data
Terrorism and lllicit Daily Treasury Yield Curve Rates [=]
Finance
Select Time Period
Data and Charts Center Current Month Iz‘
Agency MBS Purchase
Program Date 1Mo 3 Mo 6 Mo 1¥Yr 2¥r 3Yr 5¥r TYr 10¥r 20¥Yr 30Yr
Interest Rate Statistics 04/01/13 0.06 0.08 011 0.14 0.23 0.36 0.76 123 1.86 270 3.08
e Class Anction 04/02/13 0.06 0.07 011 0.14 025 0.36 0.78 126 188 272 310
Allotments
Monitoring the Economy 040313 0.06 0.08 010 013 024 034 073 120 183 266 3.05
Quarterly Refunding 04/04M13 0.07 0.07 0.10 01z 022 0.33 0.89 118 178 280 2.99

In this example, the expiry of the option is in 11 days’ time. We can use a one month yield rate from
the date roughly one month before our option expires, as offered by the treasury. In this case we
use 0.07%. Note that there is not a single correct risk-free rate to use. Any short-term government
bill will suffice.

Date 1 Mo 3 Mo & Mo 1¥r 2Yr 3Yr 5Yr TYr 10 ¥r 20¥r 30 ¥r
04/01/13 0.06 0.08 011 0.14 0.23 0.36 0.76 1.23 1.86 270 3.08
04/02113 0.06 0.07 011 0.14 0.25 0.36 078 1.26 1.88 272 310
04/03/M13 0.06 0.06 0.10 0.13 0.24 0.34 073 1.20 1.83 266 3.05
04/04/13 0.07 0.10 013 022 0.33 0.69 1.15 178 2,60 2499
04/05M13 0.05 0.07 0.10 0.13 0.24 0.33 0.68 1.12 172 250 287
04/08/13 0.05 0.07 0.10 013 0.24 0.34 0.71 1.15 176 254 29
04/09/13 0.06 0.06 0.10 013 0.24 0.34 0.70 1.16 178 257 294

e Input this value into the spreadsheet in cell E7.
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Implied Volatility Spreadsheet (Zero Dividend Model)

Data Inputs
Spot Price Expiry Date
Strike Price Days 11.00

Risk-Free Interest Rate

=7 = w

Time to Maturity 0.030
Observed Option Price Market Call Premium
Black-Scholes Theoretical B.S Call Premium 13.5998865

Option Price

Now we are going to use Excel’s Solver add-in to set the theoretical option price to match the
observed market option price by changing the volatility input only. This will give us our implied
volatility.

Firstly, we need to install the “Solver Add-In" into Excel - if it isn’t already.

For Excel 2003

1. On the Tools menu, click Add-Ins.
In the Add-Ins available box, select the check box next to Solver Add-In, and
then click OK.

Tip: if Solver Add-In is not listed, click Browse to locate it.

3. If you see a message that tells you the Solver Add-In is not currently installed
on your computer, click Yes to install it.

4, Click Tools on the menu bar. When you load the Solver Add-In, the Solver
command is added to the Tools menu.

For Excel 2007, (2010)

Click (File)=>Options, and then click the Add-Ins category.
Near the bottom of the Excel Options dialog box, make sure that Excel Add-
ins is selected in the Manage box, and then click Go.

3. In the Add-Ins dialog box, select the check box for Solver Add-In and then
click OK.
4, If Excel displays a message that states it can't run this add-in and prompts

you to install it, click Yes to install the add-in.
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e Now navigate to solver through Data—=>Solver
Data Review View Developer Add-Ins 4
B ;-r;o Mections 4| [Tz \T E3 E‘E E [ “@E E: =>.ﬂr ~.‘:r L*ED = B Data Analysis
ISP Properties & 312 § =0 ‘Zb ? L 49 5 -
~ il Sort Filter Y ' Textto  Remove Data Consolidate What-If Group Ungroup Subtotal
=2 Edit Links A2 Advanced | Columns Duplicates Validation = Analysis ~ - -
nections Sort & Filter Data Tools Outline Fl Analysis
Solver
E F G H J L M N 0 ‘What-if analysis tool
. optimal value of a tar:
readsheet lZEI'O Dividend MOdEl] changing values in ce
calculate the target cf
Resources &3 SOLVER
. B . Press F1 for add-in
Options Data  http//www.cboe.com/ or http:/ffina

13.6998865

q

Risk-Free Rate http://www treasury goviresource-

center/data-chart-center/interest-
rates/Pages/TextView.aspx?data=yield

httpe/finance yahoo.com/

Short-term treasury yield rates
can be used as a proxy for a
risk-free rate

or company websites (for
equities)

Solver should now present a screen like the following.

Solver Parameters

ariable Cells:

Constraints:

() value Of:

Change

Delete

Reset Al

- Load/Save

Set Objective:
To:
By Changing V,
|
l Subject to the
I
{
I Select a Solviny

non-smoath,

Make Unconstrained Variables Non-Megative

g Method: GRG Monlin

Solving Method

ear

D[]

Select the GRG Monlinear engine for Solver Problems that are smooth nonlinear. Select the LP Simplex
engine for linear Solver Problems, and select the Evolutionary engine for Solver problems that are

_
C=

i, L

In case the cells are not already entered into the Objective and Variable inputs, take the following

steps:

Now click Solve.

In the Set Objective input, type “SFS17”.
In the By Changing Variable Cells input, type “SF$20”.
Set the function to a minimisation procedure by clicking “Min”.

Solver now attempts to use an iterative procedure to minimise the difference between the observed

option price and the theoretical option price by changing the volatility input into the theoretical
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option price equation. The next window should say that “Solver has converged to the current
solution. All constraints are satisfied”.

F G H | J kK L
Zerg Solver Results Iﬁ
Sclver has converged to the current solution. All
Censtraints are satisfied. Reports
Answer com/
Sensitivity
Limits ury.go
{0 Restore Original Values -cents
(tView.
[ Return to Solver Parameters Dialog [ outline Reports Bhoo.co
8
OK Cancel Save Scenario...
Solver has converged to the current solution. All Constraints are satisfied.
a4 Solver has performed 5 iterations for which the objective did not move
1 significantly. Try a2 smaller convergence setting, or a different starting point.
0.{:
|
If Solver could not find a solution, take the following steps:

e Change the volatility manually (in the red box) to a value between 0.1 and 0.3 and try again.

Note when changing this volatility we can observe the theoretical B-S option price changes in cell

E12 change. Keep changing the volatility until you start to converge the theoretical price (E12) to the

observed price (E10). When the values are similar, solver may work in a more robust manner.
[ )

If the above step still does not work, try using a call option with a slightly different strike
price.

After Solver is successful we can close the box by pressing OK, and observe the implied volatility in
the spreadsheet:

=
Solver Results &J
Solver has converged to the current sclution. all
Constraints are satisfied. Reports
.................................................... Ansh\l’e‘r
Keep Solver Solution; Sensitivity
Limits
O Restore Criginal Values
[ Return to Solver Parameters Dialog [ outline Reports
I 1'»} Cancel Save Scenario..
Solver has converged to the current solution. All Constraints are satisfied.
Solver has performed 5 iterations for which the objective did not move
significantly. Try a smaller convergence setting, or a different starting point.
il |
L 1
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Solver Input and Output

Difference between real and theoretical prices (squared) 1.368E-17
Implied volatility —
Volatility (sigma) 0.1414821

In this example we have an implied volatility of 0.14. This is an annualised volatility measure implied

by our 11-day forward looking call option. We can compare this value to the VIX (implied volatility

also calculated from S&P500 options), and it should be fairly similar. Reasons for slight discrepancies

between the VIX and the implied volatility we have calculated here will be down to the method of

calculation used in the VIX. The VIX calculates the annualised volatility based on a weighted average

of a large number of options with different strike prices and expiry dates. It aims to display 1-month

forward looking volatility in an annualised format and scaled up by 100. Another reason for

deviation from the VIX would be the volatility smirk mentioned at the beginning of the guide. By
choosing options close to the money we are going to obtain an implied volatility that is lower than
an average implied volatility over a number of different strikes. Let’'s compare this figure to the VIX

now.

e Go to http://finance.yahoo.com
e Type “VIX” into the Get Quotes box.

Hew User? Register | Signin | Help Make Y! My Homepage |

Mail | MyY?! | #& Yahoo!

YAHOO! FINANCE B

UK & IRELAND

INVESTING NEWS & OPINION MY PORTFOLIOS PERSONAL FINANCE PROPERTY

| Get Quotes ‘

FTSE 100 +0.68%

Search Web

REAL MONEY

QUOTES VOLA TYS&PS500 (*VIX) - Chicago Opfions
> Summary 2.59(14.75%) 19.pr21:14

4k Add to Portfolio

Options

Prev Close: 17.56 Day's Range: 14.87 -16.98 :'?VII-:TILITYss.Psuu

Historical Prices

CHARTS Open: 16.67 52wk Range: 11.05 -27.73

NEWS & INFO
© Yahoo! UK & Ireland

1000 1200

Headlines 1d 50 1m  3m

Interactive
Basic Chart 16
Basic Tech. Analysis People viewing AVIX also viewed:

VXX TVIX UVXY XIV SPY FAZ 15

S 4
1400 1600

Previous Closs

6m 1y 2y By ma

customise chart

Remember the VIX is displayed by scaling up the annualised volatility by 100. In this example the

implied volatility measure has worked particularly well. But remember that we have used one near-

the-money option (so we expect a slightly lower implied volatility) and the option is only forward

looking by 11 days and not a month as the VIX is.
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http://finance.yahoo.com/

However, we can still use this option to calculate implied standard deviations of the underlying asset
returns over different periods. Next, we will transform our implied volatility into a monthly standard
deviation measure, which has more practical implications.

e Incell F23 type “=F20/SQRT(12)”. Press Enter.

19
20 Volatility {sigma)
1
22 Auxillary inputs to calculate B-S premia

0.1414821

23]

24
25
26

d1

0.15081

d2 N -"dash"

(d1)

0.126249018 0.394431

|=F2[].FSQR'I'_(12]|

19

21

20 Volatility (sigma)

22 |Auxillary inputs to calculate B-S premia

23]

24| di d2 N “dash"
25 (d1)
26 0.15081  0.126249018 0.394431

I 0.0408424!

e Right-click on cell F23 and go to “Format Cells”.

Black-zcholes Theoretical

B-5 Call Premium

Option Price

Delete...

Clear Contents

Solver Input and Output

Difference between real and theoretical prices (squared)

Volatility (sigma)

Filter
Sort

1.368E-1 —d Insert Comment

0.141482 Pick Fraom Drop-down List...

Define Name...

Auxillary inputs to calculate B-S premia

Hyperlink...

w
Moaneazi.

e Go to the “Number” tab and select “Percentage” as the Category. Display the figure to two

decimal places. Press OK.
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Number |AJignment| Fant | Border | Fil IProtection|

Category:

General » | Sample
MNumber 4.08%
Currency

g;i:unﬁng Decimal pIaces@ 3

JdPercentage
Fracto
Scientific
Text
Spedial
Custom

Percentage formats multiply the cell value by 100 and displays the result with a percent symbal,

CoD)

Solver Input and Output

Difference between real and theoretical prices (squared) 1.368E-17
Volatility (sigma) 0.1414821

Auxillary inputs to calculate B-S premia e

[ ( 4.08%1
d1 d2 N -"dash"

(d1)
015081  0.126249018 0.394431

This finds a one month standard deviation based on our annualised volatility figure. Assuming the
returns of the S&P500 are normally distributed (remember the Returns Distribution tutorial) we can
take this figure to mean that there is a 68.2% probability that the S&P500 will move by up to 4.08%
either side of its average return in the next month. Refer back to the Returns Distribution tutorial to
remind yourself of the normal percentage probabilities for 2 and 3 standard deviations either side of
the mean. But remember this figure is scaling up from a volatility implied by a 11-day option. Ideally,
to obtain a one-month forward looking volatility (and hence standard deviation) measure we would
want to use an option with expiry exactly one month from today.

However, in this example we can get true implied volatility estimate of the next 11 days by using this
option:

e Change the cell formula to “=F20/SQRT(365/11)”
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Solver Input and Qutput

Difference between real and theoretical prices (squared) 1.368E1T
Volatility (sigma) 0.1414821

Auxillary inputs to calculate B-S premia

[EFz0/saRT(365/11)

d1 d2 N -"dash"
(d1)
0.15081  0.126249018 0.394431

Solver Input and Qutput

Difference between real and theoretical prices (squared) 1.368E-17
Volatility (sigma) 0.1414821

Auxillary inputs to calculate B-S premia

I 2_46%!

d1 d2 N -"dash"
(d1)

015081 0126249018 0 394431

Assuming normally distributed returns implies:

A Probability Of That the S&P500 returns within .... Of its
average returns in the next 11 days
68.2% 2.46%
95.4% 4.92% (2*2.46%)
99.8% 7.38% (3*2.46%)
Summary

As a forward-looking volatility measure, implied volatility has been shown to more accurately predict
future volatility levels than traditional historical returns approaches. This guide has shown how you
can calculate your own implied volatilities on given assets, and discussed how to transform them
into more meaningful statistics (standard deviations) that you can apply in your portfolio
management techniques. More importantly, implied volatility gives an idea of our future trading
opportunities and will be the first-move volatility indicator at our disposal that helps us decide
between shorter term trading strategies against longer term portfolio management approaches.
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